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Fit for Purpose- Layers of Analytics using the PI
System — AF, MATLAB, Machine Learning

Lab Description

This hands-on lab covers scenarios to illustrate the different levels of analytics that are fit-for-purpose
when using the P1 System - for example, what calculations and analysis do you do in AF, when do you
use MATLAB and similar libraries for advanced calculations that hook into AF and when do you call on
“data science and machine learning . Use cases will include those focused on an equipment i.e. pump or
motor or compressor etc. and those focused on a process. We will also cover examples of advanced
analytics that are part of the data collection from the edge devices and contrast it with predictive analytics
— both the model development and model deployment (scoring new incoming real-time data).

Level: Pl User Track — Power User Duration: 3 hours

Introduction

Layers of analytics can be viewed through many lenses. It can refer to the levels of complexity and the
kinds of computations required to transform “raw data” to “actionable information/insight.” The
complexity level varies due to:

= amount of data required for computation
= nature of the computation/calculation, and
= frequency of the computation

In the above, the nature of the calculation dictates the amount of data required (a single measurement
or a few measurements or 60 measurements for every minute of the last hour etc.) for one or more
variables in the calculation. Plus, the physics of the process, dictates how often or the frequency of the
computations as new measurements arrive in real-time.

The calculation performed on the “raw data” can be categorized into:

=  Calculation that is once-through and done using a step-by-step procedure
=  Calculation involving iterative steps
» Calculation involving complex math/statistics or data science/machine learning logic

As such, the effort required - both human and computational - has a wide range. And, even though data
science/machine learning tools are now widely available, they don’t replace physics based calculations
you can do with “raw data” to transform it to useful information.



Layers of analytics is also often categorized into:

= descriptive analytics - what happened

= diagnostic analytics - why did it happen

= predictive analytics - what can/will happen

= prescriptive analytics - what should | do, i.e. prescribing a course of action based on an
understanding of historical data (what happened and why) and future events (what might
happen)

The purpose of the analytics i.e. whether it is for descriptive or diagnostic or predictive or prescriptive
will influence the “raw data” calculations and transforms. The following graph shows “value vs.
difficulty” as you traverse the layers.
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Source: Gartner

Layers of analytics can also be categorized by where the analytics is done, such as:

= Edge analytics
=  Server based analytics
=  Cloud-based analytics

Analytics at the edge include those done immediately with the collected data, to lessen network load by
reducing the amount of data forwarded to a server - for example, Fast-Fourier Transform (FFT) on
vibration time wave-forms to extract frequency spectrums. Or, when an action is to be immediately
taken based on the collected data without waiting for a round-trip to a remote analytics server - for
example...



Layers of analytics can also be viewed through “scope of a business initiative” lens — for example, in
asset maintenance and reliability, the layers are:

=  UbM - Usage-based Maintenance - AF
=  CbM - Condition-based Maintenance - AF
=  PdM - Predictive Maintenance - AF plus third party libraries

Effectiveness
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In the hands-on portion of this Lab:

= Exercise 1 uses an oil refinery process unit operation - Alkylation Feed Dryer - to walk-through
the layers i.e. descriptive, diagnostic, predictive and prescriptive

= Exercise 2 uses a maintenance/reliability scenario (pump/motor assembly) to illustrate the
layers i.e. UbM, CbM, and PdM

Items not included in the detailed hands-on portion will be covered as discussion topics during the Lab.



Pl System software
The VM (virtual machine) used for this lab has the following Pl System software installed:

Software Version ‘

Pl Data Archive 2018 pre-release
Pl Asset Framework (Pl AF) server 2018 pre-release
Pl Asset Framework (PI AF) client (Pl System Explorer) 2018 pre-release
Pl Analysis & PI Notifications Services 2018 pre-release
Pl Vision 2017 R2

Pl Web API 2018 pre-release
Pl UFL Interface 3.4.22.28

For details on Pl System software, please see http://www.osisoft.com/pi-system/pi-capabilities/product-

Jist/



http://www.osisoft.com/pi-system/pi-capabilities/product-list/
http://www.osisoft.com/pi-system/pi-capabilities/product-list/

Exercise 1 — Alkylation Process Feed Dryer — Analytics

In this lab, we use of Pl Event Frames to label operating conditions captured
during the regeneration process of two process feed dryers. The dryers are
cycled back and forth to continuously remove moisture from the feed before it
combines with a strong acid which serves as a catalyst for the chemical reaction.

Even small amounts of moisture entering the reaction create a highly corrosive
environment that will damage and compromise the equipment metallurgy. The
modelling objective is to create a temperature profile representing proper
regeneration of the dryer bed which is critical to this process.

This profile will be developed in R/MATLAB and operationalized through AF
Analytics and Pl Vision. The data used for this Exercise comes from an actual
processing facility and spans 2017 at six-minute intervals.

la: Feed Drying Process

Use the desktop “Dryer Process Flow” shortcut to open a Pl Vision display showing the feed dryer
process flow

The dryers contain a bed of desiccant and molecular sieve material which removes moisture from the
hydrocarbon stream passing through it at ambient conditions. The absorbed water is then removed
during the regeneration process by passing the hydrocarbon stream through the bed at elevated
temperature, 450-500 F.

In the display, green represents a “Process” state where the bed is drying (or available for drying) the
process feed. Red represents a “Regeneration” state where the bed is being regenerated. You can see
the alternating dryer modes by advancing the time range of the display.
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Trends of the Outlet Temperatures for each bed are also shown; we focus on these temperature profiles
in this Exercise.



The trend for Dryer B, below, shows the rise in temperature that occurs when the bed is being
regenerated. Therefore, the It is a good indicator for determining the current operating state of the
dryer and is a critical variable when monitoring the regeneration cycle.

Dryer B Outlet Temperature, F

1b: Data Preparation with AF Expression Analytics

Open Pl System Explorer from the taskbar and choose the “Dryers” database. Click on “Dryer A” to
select this asset. You will use the “Attributes” tab to access the asset hierarchy and the “Analyses” tab to

access the analytics.

The attributes associated with the “Dryer” template is shown below; note the “Process System” and
‘Regeneration System” categories. The categories “Dryer Bed Conditions” and “Dryer State” contain
attributes which are derived from descriptive analytic calculations we make using AF Analytics.

Elements
% Elements
)
J Dryer8
\ Element Searches

L Elements

~ Event Frames

4. Library

== Unit of Measure

A Contacts

as

Dryer A

General Child Elements Attributes Ports Analyses Notification Rules Version

Excluded attributes are hidden. Group by: [/] Category [[] Tem|
Fiter e

ll t @& R Name 4 Value

B Category: Dryer Bed Condition

LK J # Dryer Bed Processing Age 45.1744
B & | ¥ Lfetime Total Dried Feed 2384756.5
[] 2J Molecular Sieve Loading 52790 ft3
B . Category: Dryer State
B & | ¢ Operating State Regeneration
B _J Category: Process System
= # Dryer Pressure 167.0772 psg
] # Moisture Content 1.8 ppm
=] = { & Outlet Temperature {169.5 deg F
(] <1 End of Regeneration Temperature 175deg F
= . Start of Regeneration Temperature 170 deg F
L] ¥ Process Flow 8689.8 bby/d

B _J Category: Regeneration System

L] # Hot Of Flow 0 bbyd

L] % Hot Oi Valve Position 8%

= # Regenerant Flow 601.0433 bbyd
L # Regenerant Return Drum Level -1.844879 %
L] # Regenerant Return Drum Pressure 164.783 psi

= # Regenerant Temperature 173.3deg F

Sub-attributes under the “Outlet Temperature” attribute are temperature limits to define the start and
end times of the regeneration cycle. These have been chosen after inspecting the PI Vision trends. Also
note the “Molecular Sieve Loading” attribute of the Dryer asset model. This attribute has been looked
up from an AF Table containing asset specifications.



Calculating “Operating State”

In PI System Explorer, select the “Analyses” tab at the top of the window. Select the “Dryer Status”
analytic.

We will describe the operating state of each dryer using a digital state tagin PI. This will be a
fundamental building block for the rest of our analysis. The analytic expression, “Dryer Status”, sets the
digital state value of the “Operating State” attribute for each dryer. The digital state value is set to
either “Process” or “Regeneration” based on the dryer “Outlet Temperature” and the past value of the
“Operating State”.

Dryer A
General Child Elements Attributes Ports  Analyses MNotification Rules Version
g > Name: Dryer Status
e B ® @ Name Backfilling Desaription:
? u J©  DryerBed Age Categories:
2 =n IH Dryer Regeneration Events (/] Analysis Type: '® Expression Rollup Event
2 n f®&  Dryer Status

Name Expression

If('Outlet Te
And Pr
Then (If Prewv\
Then * tput()
Regenstatus Else "Regeneration")
Else

The Operating State is set to “Regeneration” when the dryer Outlet Temperature rises above the “Start
of Regeneration Temperature” (170 F) and set to “Process” when the dryer Outlet Temperature false
below the “End of Regeneration Temperature” (175 F). We’ve added a second condition requiring at
least a 5-hour elapsed time between this regeneration and the last, keeping small temperature
fluctuations from falsely concluding Event Frames near the start of the regeneration.

Use the desktop “Dryer Status” shortcut to open the PI Vision display showing the feed dryer states.

Once this analytic was configured, the backfilling feature of AF Analytics was used to process the events
in the Pl Archive to populate the digital state tags for each dryer.
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Dryer Regenerations

This display shows the outlet temperature and operating state for both dryers. Notice that the

regenerations do not appear to follow a set schedule and that the cycle durations can vary — from about
6 hours to sometimes more than 12 hours.

Calculating “Dryer Bed Processing Age”

Open the PI Vision display showing the feed dryer process flow using the “Dryer Bed Condition”
shortcut on the desktop, or from the Favorites list in Pl Vision.

Repeated cycles between temperature extremes affect the bed’s drying properties. To account for this,
we will add a descriptive value to assess the processing age of each bed.

Dryer Bed Condition - Mol Sieve Age

Dryer A Processing Age

Dryer B Processing Age

We have defined the processing age of a dryer bed to be:

Lifetime volume of feed dried by a bed (bbl.)
Molecular sieve load in dryer (Ib.)

The purple trace shows the Dryer Processing Age for Dryer A. The age is ever increasing except when
the dryer is being regenerated. The teal trace in the trend shows the feed flowrate. We need to keep a
running total of this value for each dryer to provide the Lifetime volume used in the Processing Age
calculation. The gauge symbol shows that Dryer A has dried more barrels of feed than Dryer B.
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Return to PI System Explorer, select “Dryer A” and use the “Analyses” tab to access the analytics. Select
the “Dryer Bed Age” analytic.

The analytic expression, “Dryer Bed Age”, calculates the processing age for each dryer bed using the
following steps (names correspond to those in the AF Template configuration shown below).

e To obtain the interval start time for calculating the total feed volume, retrieve the timestamp for the
last archived value of the Process Flow, (PreviousProcesFlowTime).

o Ifthedryerisinthe “Process” state and the previous and current values of the Process Flow are
good, add the incremental total to the lifetime total, (LifeTotal).

e Calculate the Dryer Processing Age based on the definition given above, (DryerBedAge).

| Dryer
General AMtribute Templates Ports ~ Analysis Templates Notification Rule Templates
\_:E Name: Dryer Bed Age
[ ® @ MName Description: | Processing Age of Molecular Sieve
ftd  Dryer Bed Age Categories.
H  Dryer Regeneration Events Analysis Type: (8 Expression Rollup Even
f9  Dryer Status ] Enable analyses when created from template
Example Element: Dryer &
Name Expression

PreviousProcessFlowTime
r

nt('Process Flow', '*')

If ('Operating 5t
And Not(BadV. o
And Not(B: ‘Process Flow',
Then 'Lifetime Total Dried Feed' + gTot('Pr

Else NoOutput()

LifeTotal

DryerBedAge 5 . ) . '
ryerBedag LifeTotal / 'Molecular Sieve Loading

Note: The TotTag() function handles the unit conversion of Process Flow (bbl/d), a volumetric flow rate,
and returns the correct volume, in bbls for any time increment. This is an inherent feature of AF
Analytics which can be a difficult challenge when analyzing unevenly spaced data from instrumentation.

1c: Data Preparation with AF Event Frames

Within PI System Explorer, under the “Analyses” tab, select the “Dryer Regeneration Events” analytic.

Event Frames define and record interesting periods of process operation for analysis. In addition, Event
Frame templates can make other process features available for analysis and insight. We can leverage
the Operating State attribute for each dryer to define the regeneration Event Frames. A new Event
Frame is started when a dryer’s Operating State switches to “Regeneration”. By default, the Event
Frame will end when the Operating State returns to “Process”.

B Start tnggers

'Operating State'="Regeneration”

12



We have used a NEW feature of the Event Frame Generation analytic (AF 2017 R2) to capture some
other descriptive features of the regeneration process, calculated at the event end time. We have
defined two variables; EFStartTime- the current regeneration cycle start time, and PreviousEFEndTime —
the previous regeneration cycle end time.

B Variables
EFstartTime
PrevEvent('Operating State', "*°)
PreviousEFEndTime
PrevEvent( 'Operating State’,PrevEvent('Operating State’', '*'))

With these variables defined, we can add the following features related to each regeneration Event

Frame.

e TotalProcessedFeed — The barrels of feed passing through a dried in its previous Process cycle.

Hypothetically, more barrels processed means a wetter bed at the start of the regeneration.

This may affect the outlet temperature profile. (See picture below.)

e MaxProcessedMoisture — Maximum value of the moisture analyzer during the bed’s previous

Process cycle.

e TotalRegenerant — Total barrels of regenerant used during this Regeneration cycle.

e TotalHotOil — total barrels of hot oil used during tis Regeneration cycle.

B Cutputs at close

TotalProcessedFeed

TagTot('Process Flow', PreviousEFEndTime, EFStartTime)

MaxPocessedMoisture

TagMax('Moisture Content', PreviousEFEndTime, EFStartTime)

TotalRegenerant

TagTot( ' 'Regenerant Flow', EFStartTime, '*')

TotalHotOil

TagTot('Hot 0il Flow', EFStartTime, '*')

i minnie-

4560 bbl. 6689 bbl. 5934 bbl. 3493 bbl.

Total Processed Feed in Barrels

13




Within PI System Explorer, switch to the “Library” view (lower left-hand corner). Under Event Frame
Templates, select the “Dryer Regeneration Cycle” template.

In addition to the calculations above, we can define features as attributes within the Event Frame
template. These attributes provide basic aggregations of process values associated with the Dryer asset
template. As shown in the “Dryer Regeneration Cycle” template below, we have included several
guantities to give us insight for modelling the dryer regeneration outlet temperature profile. Onein
particular, “Dryer Processing Age”, will include this value, as of the start of the Regeneration cycle.
Perhaps the age of the molecular sieve has an effect?

Library Dryer Regeneration Cycle
@D Dryers General Attribute Templates
= T%,DL?ES | Group by: [] Category [] Template
[=h [ Element Templates
- G Dryer [ Aiter £ =[] Hame: [bryer erocessing age |
- Mg Event Frame Templates | 21/ 8Name - Description @ Description: [ |
- =5 Dryer Regeneration Cyde .
- [, Model Templates =] Category: Asset Attribute Aggregations Properties: <None> N

[

- iy Transfer Templates

@ Enumerstion Seis Avg Hot Oil Valve Position Categories: Asset Attrbute Aggregations ‘
: None > v
“, Reference Types & Avg Outiet Temp Default UOM: |
) Tables Value Type: Single ~
I% Table Connections < Avg Regen Drum Level = <
= (] Categories Defauit value: [0 |

Avg Regen Temp

(&) Analysis Categories

v Data Reference: | PIPaint ~
- (] Attribute Categories § G Dryer Processing Age i
~ (@] Element Categories t Settings...
& Max Outlet Temp »
-~ (& Motfication Rule Categories .\Elements[.]|Dryer Bed Processing Age;TimeRangeMethod=5tar tTime
Reference Type Categories CE Max Regen Temp
- (E] Table Categories
=] Category: Event Frame On-Demand Aggregations
5 Elements Max Processed Maisture Maximum maisture reading for previous processing cyde.
— Event Frames =3 Total Hot Oil Flow Total hot ol used during regeneration cydle.
159 Library =4 Total Processed Feed Total feed dried during previous processing cydle.
e Unit of Measure Total Regenerant Flow Total regenerant used during regeneration cyde.
&4 Contacts
%® < > Limits Forecasts

Ever increasing age of molecular sieve
drying bed, bbl./Ib.

Dryer Processing Age at Start of Regeneration Cycle

Within PI System Explorer, switch to the “Event Frames” view (lower left-hand corner). Under Event
Frame Searches, select the “Dryer A Regenerations” search to see the Event Frame records.

The Event Frame records shown below have been created by backfilling.

14




Next, we will publish this data along with interpolated values showing six-minute samples of the process
data taken during the regeneration cycle. This dataset is then used in R/MATLAB.

Event Frames Dryer A Regenerations
I Event Frame Searches Group by: [] Category [] Templa
i kg Dryer ARegenerations | [ g )
fil b Dryer 8 —=
4 Transfer Searches =) B/ A|Name Duration | Total Processed Feed | | Avg Outiet Temp | | Max Outlet Temp | | Dryer Processing Age | | Total Regenerant Flow | | Avg Regen{Sing
feh- ¢ Transfer Search 1 * — Dryer ARegneration 07-21-17 11:06 | 5:06:00 1666,731 bbl 174.0186 deg F 186.2 deg F 22.1820259 106.1001 bbl 173.5343 deg F
* i Dryer ARegneration 07-22-17 18:42 | 20:42:00 | 10663.4 bbl 291.3568 deg F 432.2deg F 22.3339436 426,4331 bbl 324.7915 deg F
* = Dryer ARegneration 07-25-1705:42 | 13:00:00 | 14218.58 bbl 324.2181deg F 436.5deg F 22.6532764 257. 7753 bbl 377.8054 deg F
#+ I Dryer ARegneration 07-26-17 04424 | 5:06:00 2036.92 bbl 168.8039 deg F 171degF 22,6919 116.8521 bbl 171.9892deg F
+ i Dryer ARegneration 07-26-17 17:36 | 5:06:00 1722,225 bbl 169.0775 deg F 170.5degF 22.7246151 116.7605 bbl 172.298 deg F
* F— Dryer ARegneration 07-29-17 15:06 | 16:00:00 | 17775.87bbl 299,9694 deg F 442.2deg F 23.06107 367.4185 bbl 325.0922 deg F
* = Dryer ARegreration 07-30-17 12:12 | 7:24:00 1985358 bbl 179.0777 deg F 186.2deg F 23.0986325 173.4062 bbl 172.3743 deg F
> = Dryer ARegneration 08-01-1702:48 | 18:42:00 | 12496.37bbl 289.5765 deg F 447.4deg F 23.3353558 435.5629 bbl 309.5284 deg F
#+ F— Dryer ARegneration 08-03-1702:18 | 14:00:00 | 11169, 18 bbl 314.391deg F 437.6degF 23.5471287 331345 bbl 365.46 deg F
- i Dryer ARegneration 08-04-17 21,06 | 18:2%00 | 12048.08 bbl 374638 deg F 48,2degF 23.7753029 459,4142 bbl 414,3326 deg F
* = Dryer ARegneration 08-06-17 19:18 | 14:2%:00 | 11598,77bbl 298,942 deg F 48,3 deg F 23.9950066 331,366 bbl 351.0764 deg F
* = Dryer ARegneration 08-08-17 19:12 | 13:2%:00 | 14180.17 bbl 3241198 deg F 49,2 deg F 24,263607 3115576 bbl 3618343 deg F
5 Elements > = Dryer A Regneration 08-09-17 13:42 | 5:06:00 2159.564 bbl 154.1471 deg F 192.1degF 24.3045082 106.7602 bbl 284.4951 deq F
 Event Frames #+ i Dryer ARegneration 08-10-17 20:3 | 13:2400 | 107316 bbl 3221735 deg F 445.2degF 24,50776 308.8305 bbl 356.2787 deg F
- Library - F— Dryer ARegneration 08-12-17 17:54 | 14:18:00 | 13218.42bbl 318.1252deg F 442.8degF 24,7581615 306,916 bbl 366.9633 deg F
T * = Dryer ARegneration 08-14-17 13:54 | 13:06:00 | 1249455 bbl 3290424 deg F 4335 deg F 249948616 300.5331 bbl 378.3199 deg F
YT = Dryer A Regneration 08-15-1708:06 | 5:06:00 2053.163 bbl 134.6098 deg F 170 deg 7 25.0337486 108.2725 bbl 327.3314deg F
- + i Dryer ARegneration 08-16-17 10:48 | 12:18:00  |8639.622bbl 335.1362deg F 438 degF 25.1973972 277.0532bbl 388,298 deg F

1d: Shaping and Publishing Data with the Pl Integrator for Business Analytics

Open the PI Integrator for Business Analytics from the desktop shortcut.

To review the Event View publication configuration, open the desktop shortcut “Pl Integrator for
Business Analytics”. Select the “Feed Dryer Regenerations” publication and click on the Modify
Publication button at the top pf the browser window. Modify the publication name to be something
different and when prompted and click Ok to proceed to the Select Data page.

Event View shaping can involve two steps, which is the case in this example. First, we will select from
the attributes defined in the Event Frame template and included in their records. These are attributes
defined in the Event Frame template and are shown under the “Event Frames” tab in the left-hand pane.
They usually report aggregations, (total, average, maximum, minimum) of important values, taken over
the duration of the Event Frame. In this example, we will add all attributes to make them available for
our analysis in R/MATLAB.

15



Select Data > Modify View > Publish

Source Events Search Shape Matches
=
Server CHERTLER7450 v %,Event Shape Found 100+ Matches
S o o 4+ Dryer Regeneration Cycle # X » "8 Dryer A Regneration 01-02-17 00:00
& Avg Hot Oil Valve Position # %X » "8 Diyer B Regneration 010217 07:00
Lg & Avg Outlet Temp # % » "8 Diyer ARegneration 01-02-17 18:00
Event Frames | Assets o & Avg Regen Drum Level # % » "8 Dryer B Regneration 01-03-17 08:48
4 Avg Regen Temp - » "t Dryer A Regneration 01-03-17 2118
| » "3 Dryer A Regneration 010118 04:00 & Dryer Processing Age # %X ¥ "8 Dryer B Regneration 01-04-17 10:24
¥ *d Dryer A Regneration 0+02-17 00:00 & Max Outlet Temp # X »"H Dryer ARegneralion 01-04-17 22:54
» "4 Dryer A Regneration 01-02-17 19:00 v £ Max Processed Moisture # X » "1l Diyer B Regneration 01-05-17 0918
e & Max Regen Temp s x » " Dryer A Regneration 01-05-17 19:54
— =) Total Hot Oil Flow a4 » "8 Dryer B Regneration 01-06-17 10:18
Attributes | cirer §5] Total Processed Feed # %X »"H Dryer ARegneration 01-06-17 20:54
O select All £5] Total Regenerant Flow # %X »"H Diyer B Regneration 01-07-17 07.06
» " Dryer A Regneration 01-07-17 21:06
# Avg Hot Oil Valve Position e A
» ¥t Dryer B Regneration 01-08-17 08:24
& Avg Outlet Temp [:]
» "4 Dryer A Regneration 01-08-17 22:24
& Avg Regen Drum Level [:]
» 4 Dryer B Regneration 01-09-17 11:24
& 2va Regen Temp [:]
» "4 Dryer A Regneration 01-10-17 03:12
& Drver Processing Age [:]
» 4 Dryer B Regneration 011017 15:00
& Max Qutlet Temp L)
» 4 Drver A Reaneration O1-11-17 02:36
S Max Processed Moisture L: W)

Since we need to know the details of what happened during each regeneration Event Frame, we need to
add attributes associated with the Dryer asset template. These are shown under the “Assets” tab in the
left-hand pane. The completed Event View shape is shown below. Click Next in the upper right-hand
corner to move to the Modify View page.

Select Data > Modify View > Publish

+4 Source Events %, Search Shape  Matches
Server [ET— =] %, Event Shape A Found 52 Matches
Eor - e 4 i Dryer Regeneration Cycle R » *8 Dryer A Regneration 01-02-17 00:00
& Avg Hot Oil Valve Position R » ' Diryer A Regneralion 01:02-17 19:00
E & Avg Outiet Temp % » ¥ Dryer A Regneration 01-03-17 2118
EventFrames  Assels # £ug Regen Drum Level R » " Dryer A Regneration 010417 22:54
4 Avg Regen Temp £ R » V1 Dryer A Regneration 01-05-17 19:54
| D Dryer & & Diyer Processing Age R » " Dryer A Regneration 01-06-17 20:54
@ oers @ Max Outiet Temp Pk » *9 Dryer A Regneration 01-07-17 2106
S Max Processed Moisture £ n » 4 Dryer A Regneration 01-08-17 22:24
& Max Regen Temp # 3% ¥ "l Dryer A Regneration O110-17 0312
— %, Asset Shape » "d Dryer A Regneration 01-1-17 02:36
O select Al # Dryer Pressure 3 DREESEEETED
] MOIETIIaT STeve Loaay o & Outlet Temperature # % "8 Dver ARegneration 011417 1330
& Operating State " T # % *" Diyer A Regneration 011517 17:24
» § Outiet Temperature e ¢ Wi » ¥4 Dryer A Regneration 01-16-17 21:42
@ Process Flow e » ¥l Diyer A Regneralion O1-17-17 23:30
 Regenerant Flow ] » ¥4 Diyer A Regreration 01187 02:24
@ Regenerant Retur Drum Leve e Dryer A Regneration 01-20-17 06:30
& Regenerant Retum Drum Pressure [:] » "t Drver A Reaneration 012117 15:36
@ Regenerant Tempersture eV

The Modify View page provides the publication preview shown below. On this page, we have configured
the start and end times to correspond with the available data and have set the “Value Mode” to include
sampled values at 6-minute increments to give us the data needed to create the profile model.

16



Feed Dryer Regenerations

Select Data > Modify View > Publish

F aa Cotmn T ranrowrnen T o vt ose SiartTime End Time
s S e 12017 12:00 AW Ex ‘ ‘ 21718 12:00:00 AM
Dryer TimeStamp.StartTime Local _TimeStamp.EndTimel  TimeStamplocal  EventDuration  Elapsed Time  Dryer Pressure  Outlet T Flow g |

Dryer A 1/2/2017 12:00:00 AM /212017 5:1600AM  1/212017 120000 AM 6.3 0 170.4697 1369 6032525 2961
Dryer A 1/2/2017 12:00:00 AM 1212017 5:1600AM  1/212017 120600 AM 5.3 6 170.4824 4378 6036448 4962
Dryer A 1/2/2017 12:00:00 AM 1212017 5:1600AM  1/212017 121200 AM 5.3 12 170.495 4386 605.063 496.4
Dryer A 1/2/2017 12:00:00 AM /212017 5:1800AM  1/212017 1218:00AM 5.3 18 170.5076 1395 599.6411 1968
Dryer A 1/2/2017 12:00:00 AM 1212017 5:1600 AN 1/212017 122400 AM 5.3 2 170.5202 1103 604.6259 1968
Dryer A 1/2/2017 12:00:00 AM 1212017 5:1600AM  1/212017 123000 AM 5.3 30 170.5329 4412 6006193 4962
Dryer A 1/2/2017 12:00:00 AM 17212017 5:1800AM  1/212017 1236:00 AM 5.3 36 168.993 117 565,64 4972
Dryer A 1/2/2017 12:00:00 AM 1212017 5:1600AM  1/212017 124200 AM 5.3 12 168.3974 aa17 5524154 2931
Dryer A 1/2/2017 12:00:00 AM 1212017 5:1600AM  1/212017 1248600 AM 5.3 48 167.4794 1418 552.1945 469.9
Dryer A 1/2/2017 12:00:00 AM /212017 51800 AM  1/212017 125400 AM 5.3 54 167.0729 118 539.9404 3663
Dryer A 1/2/2017 12:00:00 AM 1212017 5:1800AM  1/2/2017 1:00:00 AM 6.3 60 168.5165 1419 5144739 1782
Dryer A 1/2/2017 12:00:00 AM 1212017 5:1600AM  1/212017 1:06:00AM 5.3 66 169.2595 4425 553105 1745
Dryer A 1/2/2017 12:00:00 AM /212017 51800 AM  1/212017 1:12:00 AM 5.3 72 168.9156 1133 553.9762 1742
Dryer A 1/2/2017 12:00:00 AM 1212017 5:1800AM  1/212017 11800 AM 6.3 78 168.5717 ym 552 9882 1738
Dryer A 1/2/2017 12:00:00 AM 1212017 5:1600AM  1/212017 12400 AM 5.3 84 168.4761 4403 552.1674 1738
Dryer A 1/2/2017 12:00:00 AM /212017 5:1800AM  1/212017 1:30:00 AM 5.3 %0 168.4373 1116 551.5862 1738
Dryer A 1/2/2017 12:00:00 AM 1212017 5:1800AM  1/212017 1:36:00AM 6.3 9% 168.3985 115 551.0049 1738
Dryer A 1/2/2017 12:00:00 AM 1212017 5:1600AM  1/212017 14200 AM 5.3 102 168.3597 4453 550398 1738
DryerA 1/2/2017 12:00:00 AM A/2/2017 5:18:00 AM  1/2/2017 1.48.00 AM 53 108 168.3209 4456 549.7706 1738
Dryer A 1/2/2017 12:00:00 AM 1212017 5:1800AM  1/212017 15400 AM 6.3 114 168.282 1159 549.1481 1738
Dryer A 1/2/2017 12:00:00 AM 1212017 5:1600AM  1/2/2017 20000 AM 5.3 120 168.2432 1461 550.6248 1738
DryerA 1/2/2017 12:00:00 AM 17212017 5:18:00 AM  1/2/2017 2:06.00 AM 53 126 168.2044 4457 552.0975 1738
Dryer A 1/2/2017 12:00:00 AM 1212017 5:1600AM  1/212017 21200 AM 6.3 132 168.1656 1134 551.2758 1738

For sampled Event Views it is often important to know s coumn

the elapsed time into the Event Frame for each record. ™ "=~
The “Add Columns” dialog (shown right) can be used et s

to add a column showing this value. From the “Time o) ) T
Column” tab change the “Time Column Options” to ;‘“‘V *
“Event Frame Relative Time”. Adding Minutes to the E'”

columns list will add the elapsed time, in minutes to o

the publication. We renamed this column “Elapsed T oo

Tl me" . Time Zone Offset

Display 5 time columns

Clicking Next in the upper-right hand corner of the page will open the Publish page. From here, we
could select “Feed Dryer Data”, corresponding to a VM subdirectory, as the publication target. Clicking
Publish and Acknowledge would start the publication, but we will not be doing this as part of this lab.

le: Diagnostic Analysis with Power B

Open the Power BI workbook titled “Dryer Regenerations Analysis” from the desktop shortcut.

Once the sampled Event View has been published, the resulting dataset can be used for diagnostic
analytics. Before performing predictive analysis in MATLAB, let’s look at the dataset in Power Bl. Open
the Power Bl workbook, “Dryer Regeneration Analysis” from the desktop shortcut. We have imported
the dryer dataset from the published text file. You can view this data by clicking the “Data” icon on the
left-hand toolbar of the Power Bl window.

The first page of the Power Bl workbook shows outlet temperature profiles for all Event Frames. A
“Dryer” slicer has been added to filter the plot to show Event Frames generated from each dryer
independently. The “Cycle Duration” slider allows filtering of Event Frame by duration. (Note: The
“Elapsed Time” axis is in minutes and the slider is in hours.)
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From the chart above, we can see that there are Event Frames that seem to be different than the rest.
Perhaps our Event Framing rule needs some refinement. We can use Power Bl to adjust the cycle
duration to eliminate these Event Frames from our analysis.

After some filtering, we will continue our Power Bl analysis using Event Frames with cycle durations
between 7 and 17 hours.

Move to the second page of the workbook by selecting “Processed Feed Analysis” tab below the
workspace. Based on our analysis above, we have filtered this page to only show Event Frames with
cycle durations between 7 and 17 hours (red box, below).
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Feed Group No. of
Regenerations

-
20,000
15,000
10,000

Here we are taking a looking at the averaged outlet temperature profiles of groups of Event Frames.
These groups are based on the Total Processed Feed feature recorded in each Event Frame record. It is
easy to create groups within multidimensional analysis tools. In this case, the groups have been created
in 5,000 bbl. Increments, e.g. “Feed Group” 10,000 contains regeneration Event Frames where 5,001 to
10,000 bbls. of feed was dried in the prior Process cycle. We have filtered our Feed Groups 0, 25,000
and 30,000 because there were not enough Event Frames in these groups to consider in our analysis.
What conclusions can you make from this plot?

Move to the third page of the workbook by selecting “Bed Processing Age Analysis” tab below the
workspace. Again, we have filtered this page to only show Event Frames with cycle durations between 7
and 17 hours.

Age Group No. of

5 Regenerations
30.00 35
20.00 37
10.00 24

Age Group No. of
® Regenerations

30.00 9
20.00 16

Filtering the data differently, this final page shows the effect of Dryer Processing Age on the outlet
temperature profiles. We’ve grouped the Processing Age into 10 bbl/Ib ranges and filtered out groups
having a small number of Event Frames. What conclusions can we make here?
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R and MATLAB

In this portion of the Lab, we will apply R/MATLAB to utilize historical feed dryer data to derive an
expected profile for the Outlet Temperature during dryer regeneration.

In an earlier section, we saw the following:

Using a series of data transformation steps and by applying process engineering principles, we will
extract a “golden profile” for the Outlet Temperature which signifies “good operation.”

1f: Extracting a Golden Run

From the PIWorld2018 folder, select R file shown below and double-click to open it in R Studio (please
be patient, R Studio takes several seconds to open).

Home  Share  View v
© = AL » ThisPC » Documents » PIWorld2018 v || Search PWorld2018 o]
7 Favorites Name - Date modified Type Sii
I Desktop | calcCurveDistance 4/15/2018 8:36 AM  File folder
Ja Downloads | RUL 4/18/2018 T:18PM  File folder
25 Recent places | Scripts 4/16/2018 7:45PM  File folder
‘R .RData 4/13/2018 7:52 AM R Workspace
1A This PC | Rhistory 4/15/2018 11:02 .. RHISTORY File
Iy Desktop % AnalyzeDryerData.mix 4/15/2018 1:06 PM  MATLAB Live Script
[ Documents # | calcCurveDistance.m 4/15/2018 11:37 .. MATLAB Code
/s Downloads | calcCurveDistance.prj 4/15/2018 8:34 AM PRI File
¥ Music | calcCurveDistanceFunctionSignaturesjson ~ 4/15/2018 8:34 AM  JSON File
& Pictures j Dryer Regenerations.txt 4/7/2018 3:59 AM Text Document
g Videos DryerATGold.csv 4/18/2018 10:06 ... Microsoft Excel Co...
% Local Disk (C3) |® DryerNew2.R 4/12/2018 7:32 AM R File
<3 Temporary Storage (D:) DryerTGold.xlsx 4/18/2018 11:39 ... Microsoft Excel W...
E goldenBatch.mat 4/14/2018 1:34 PM  MATLAB Data
% Network OutletTemperatureForecast.csv 4/18/2018 3:19 PM  Microsoft Excel Co...
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The focus of the R code walk-through is to illustrate the data analysis methodology and not on the syntax

of the language.

Equivalent MATLAB code is in goldenBatch.mat. Time permitting, we will also do a walk-through in

MATLAB.

The screen below shows the R Studio user interface.

E]

o - oy -

) DryerNew2.R

Tibrary(MESS)

getwd()

W~ U B W

10 dim(c)
11 head(c,5)

13 summary(c)
16 <

89:20  (Top Level)

Console  Terminal

File Edit Code View Plots Session Build Debug

Source on Save

Tibrary(dplyr)

suppressMessages(library(sqldf))

Tlibrary(sqldf)
setwd("C:/Users/student0l/Documents/PIwor1d2018")
#get working directory
c=as.data.frame(read.csv(file="Dryer Regenerations.txt", header:
#how many rows and columns

#show top 5 rows along with column names

Type

The following sections show the output when you step through the script line by line using Run.

Type 'demo()' for some demos,
"help.start()' for an HTML browser interface to help.

'q()" to quit R.

Q /-

'help()' for on-Tine help, or

Profile Tools Help

~ Addins ~

.“
#setwd("C: /Users/gopal/Documents/Cud == Cc18/Lab Analyticia

Tibrary(ggplot2)

#summary statistics, #note NA(s) if any
14  view(c) #grid view

R is a collaborative project with many contributors.
Type 'contributors()’ for more information and
"citation()' on how to cite R or R packages in publications.

[workspace loaded from ~/PIWor1d2018/.RData]

RStudio

—

Source ¥

v
>

R Script =

-

Envi History C

-

"} Global Environment ~
Data
a
al
al6o
al60Basis
aleOBasisordermi..
al6ORuns

Files Plots Packages

’
#* Import Dataset - "

22416 obs.
16923 obs.
10618 obs.
10370 obs.

of 25
of 25
of 25
of 25

variables
variables
variables
variables

5185 obs. of 25 variables
176 obs. of 4 variables

Help  Viewer

- Export =

L]

Rl project: (M

List =

The pages below have been extracted from the script output document *.html (see the lab folder for
the latest revision).

LS PIWorld2018 =1 .
Home  Share  View v 0
@ = L » ThisPC » Documents » PIWorld2018 v ]| Search PWorld2018 o]
17 Favorites Name Date modified Type Sizf

I Desktop | calcCurveDistance 4/15/2018 8:36 AM  File folder
/s Downloads | RUL 4/18/2018 718 PM  File folder
=i Recent places | Scripts 4/16/2018 7:45 PM  File folder
R RData 4/13/2018 7:52 AM R Workspace
1A This PC Rhistory 4/15/2018 11:02 ...  RHISTORY File
kg Desktop € AlkyFeedDryer.html 4/19/2018 824 AM  Chrome HTML Do...
{* Documents % AnalyzeDryerData.mlx 4/15/2018 1:06 PM  MATLAB Live Script
|8 Downloads " calcCurveDistance.m 4/15/2018 11:37 .. MATLAB Code
U Music calcCurveDistance.prj 4/15/2018 834 AM PRI File

21



Link to R document (HTML format)

Alky Feed Dryer

QOSlsoft Pl World 2018 - Power User Track - Fit for Purpose: Layers of Analytics using the Pl System - AF, MATLAB, Machine Learning

set working directory, load libraries and read data
#setwd("C:/Users/student@l/Documents/PINorld2818/AlkyFeedDryer"”) #set working directory

setwd("C: /Users/gopal/Documents/CustomerD74/UC18/Lab Analytics")
getwd() #get working directory

## [1] "C:/Users/gopal/Documents/CustomerD74/UC18/Lab Analytics"

library(ggplot2)

suppressMessages (library(sqldf))
library(sqldf)

suppressMessages(library(MESS))
library(MESS)

suppressMessages (1library(dplyr))
library(dplyr)

read the Pl Integrator file output

c=as.data.frame(read.csv(file="Dryer Regenerations.txt",header=TRUE,sep="\t"))

dim(c) #how many rows and columns
## [1] 49858 22
head(c,5) #show top 5 rows along with column names

## 1..Id Dryer TimeStamp.StartTime.Local TimeStamp.EndTime.Local

## 1 1 Dryer A 1/2/2017 12:00:00 AM 1/2/2017 5:18:00 AM
## 2 2 Dryer A 1/2/2017 12:00:00 AM 1/2/2017 5:18:00 AM
## 3 3 Dryer A 1/2/2017 12:00:00 AM 1/2/2017 5:18:00 AM
## 4 4 Dryer A 1/2/2017 12:00:00 AM 1/2/2017 5:18:00 AM
## 5 5 Dryer A 1/2/2017 12:00:00 AM 1/2/2017 5:18:08 AM
## TimeStamp.Local Duration ElapsedTime Dryer.Pressure
## 1 1/2/2017 12:@0:00 AM 5.3 2] 176.4697
## 2 1/2/2017 12:06:00 AM 5.3 6 176.4824
## 3 1/2/2017 12:12:@0 AM 5.3 12 176.4950
## 4 1/2/2017 12:18:@0 AM 5.3 18 1706.5876
## 5 1/2/2017 12:24:00 AM 5.3 24 170.5202
##  Outlet.Temperature Regenerant.Flow Regenerant.Temperature
## 1 436.9 603.2525 496.1
## 2 437.8 603.6448 496.2
## 3 438.6 605.0630 496.4
## 4 439.5 599.6411 496.8
## 5 448.3 604.8259 496.8
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file:///C:/Users/student01/Documents/PIWorld2018/AlkyFeedDryer.html

#% Dryer.Regeneration.Cycle Avg.Hot.0il.Valve.Position

## 1 Dryer A Regneration 81-82-17 ©0:00 15.85472

## 2 Dryer A Regneration 81-82-17 ©0:080 15.85472

## 3 Dryer A Regneration 81-82-17 ©0:80 15.85472

## 4 Dryer A Regneration 81-82-17 ©0:080 15.85472

## 5 Dryer A Regneration 81-82-17 ©0:80 15.85472

##  Avg.Outlet.Temp Avg.Regen.Drum.Level Avg.Regen.Temp Max.Outlet.Temp

## 1 318.9179 -2.085758 229.7132 446.1

## 2 318.9179 -2.085758 229.7132 446.1

## 3 318.9179 -2.085758 229.7132 446.1

#t 4 318.9179 -2.085758 229.7132 446.1

## 5 318.9179 -2.085758 229.7132 446.1

##  Max.Processed.Moisture Max.Regen.Temp Total.Processed.Feed PIIntTSTicks
# 1 -1.3 497.2 4474.716 6.361894e+17
## 2 -1.3 497.2 4474.716 6.361894e+17
## 3 -1.3 497.2 4474.716 6.361894e+17
## 4 -1.3 497.2 4474.716 6.361894e+17
## 5 -1.3 497.2 4474.716 6.361894e+17
##  PIIntShapeID

# 1 2]

## 2 2]

## 3 2]

## 4 Q

## 5 Q

summary(c) #summary statistics, #note NA(s) 1if any

## i..Id Dryer TimeStamp.StartTime.Local

## Min. : 1 Dryer A:22416 2/27/2017 1:48:80 AM : 767

## 1st Qu.:12265 Dryer B:26642 3/2/2017 11:30:80 AM : 578

## Median :24530 7/27/2017 10:24:00 AM: 438

## Mean 124530 1e/6/2017 6:30:00 AM : 343

## 3rd Qu.:36794 6/15/2017 11:24:0@ PM: 335

##  Max. 149858 9/11/2017 2:12:00 PM : 289

## (Other) 146308

## TimeStamp.EndTime.Local TimeStamp.Local

## 3/2/2017 6:24:00 AM : 767 11/2/2017 18:36:00 AM: 2

## 3/4/2017 9:12:00 PM : 578 11/2/2017 1@:42:00 AM: 2

## 7/29/2017 6:06:00 AM: 438 11/2/2017 10:48:00 AM: 2

## 10/7/2017 4:42:00 PM: 343 11/2/2017 18:54:0@ AM: 2

## 6/17/2017 8:48:00 AM: 335 11/2/2017 11:00:00 AM: 2

## 9/12/2017 7:00:00 PM: 289 11/2/2017 11:06:00 AM: 2

## (Other) :46308 (Other) 149046

## Duration ElapsedTime Dryer.Pressure Outlet.Temperature
##  Min. 1 5,18 Min. 9.2 Min. i @8.5452  Min. : 85.4

## 1st Qu.:11.20 1st Qu.: 186.0 1st Qu.:167.9203 1st Qu.:198.6

## Median :12.70 Median : 384.0 Median :168.9629 Median :337.8

## Mean :15.12 Mean 1 453.5 Mean :170.8871  Mean 1312.2

## 3rd Qu.:15.80 3rd Qu.: 594.2 3rd Qu.:170.3075 3rd Qu.:467.1

## Max. :76.60  Max. 14596.@  Max. 1348.8279  Max. 1465.0

##

## Regenerant.Flow Regenerant.Temperature

## Min. ;. @.e  Min. :187.0

## 1st Qu.: 501.5 1st Qu.:173.5

## Median : 552.1 Median :457.9

## Mean : 566.9 Mean :364.6

## 3rd Qu.: 601.2 3rd Qu.:480.9

## Max. :1388.¢  Max. :537.7

##
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## Dryer.Regeneration.Cycle Avg.Hot.0il.Valve.Position

## Dryer B Regneration ©2-27-17 01:48: 767 Min. : 7.199

## Dryer B Regneration ©3-82-17 11:308: 578 1st Qu.:39.793

## Dryer B Regneration 87-27-17 10:24: 438 Median :61.894

## Dryer B Regneration 10-06-17 06:30: 343 Mean :56.654

## Dryer B Regneration ©6-15-17 23:24: 335 3rd Qu.:75.246

## Dryer B Regneration ©9-11-17 14:12: 289 Max. 195,208

##  (Other) 146368

## Avg.Outlet.Temp Avg.Regen.Drum.Level Avg.Regen.Temp Max.Outlet.Temp
##  Min. :104.9  Min. :-5.000 Min. :171.8  Min. :170.9
## 1st Qu.:311.6 1st Qu.: 1.612 1st Qu.:354.9 1st Qu.:414.3
## Median :324.8 Median : 5.184 Median :379.3  Median :429.0
## Mean :313.3 Mean : 6.220 Mean :1365.3 Mean :411.4
## 3rd Qu.:336.4 3rd Qu.: 9.576 3rd Qu.:392.3 3rd Qu.:442.1
##  Max. 1381.9 Max. 132.497 Max. :455.1 Max. :465.8
##

## Max.Processed.Moisture Max.Regen.Temp Total.Processed.Feed

##  Min. :-1.30 Min. :171.9  Min. T 672.9

## 1st Qu.: 5.80 1st Qu.:471.9 1st Qu.: 6407.4

## Median :15.60 Median :485.5 Median :11862.3

## Mean :19.43 Mean :473.8  Mean 111211.7

## 3rd Qu.:25.80 3rd Qu.:496.2 3rd Qu.:14553.9

##  Max. :63.00 Max. :537.7  Max. 132177.2

##

##  PIIntTSTicks PIIntShapelID

##  Min. 16.362e+17  Min. H-]

## 1st Qu.:6.363e+17 1st Qu.:@

## Median :6.363e+17 Median :@

## Mean 16.363e+17 Mean HJ

## 3rd Qu.:6.364e+17 3rd Qu.:©

##  Max. 16.365e+17 Max. H

#H#

#c=na.omit(c) #remove rows containing NULL values, if any

grid view

View(c)

data manipulation

a=subset(c,Dryer==
b=subset(c,Dryer==
dim(a)

‘Dryer A')
Dryer B')

## [1] 22416 22

dim(b)

## [1] 26642 22
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View(a)

the timestamps in the rows are in sequence and 1in increasing order for each Cycle

#it is easier to work with Cycle number instead of names, so convert to numeric IDs 1, 2, 3 etc.

a$Cycle=0

k=1

a$Cycle[1]=1

for (j in 2:nrow(a)) {

if (a$Dryer.Regeneration.Cycle[j]==a$Dryer.Regeneration.Cycle[j-1]) {

a$Cycle[j]l=k
}
else {
k=k+1
a$Cycle[j]=k
}
}

max(a$Cycle) #193 Cycles

## [1] 193

a$T=a$Outlet.Temperature #shorten the name

a$Time=a$ElapsedTime/6 #easier work in 6 minute (8.1 hour) increments, Regen Cycle runs for several hours

#plot of Outlet Temperature for each Cycle (Event Frame) - overlaid
geplot(data=a)+aes(x=Time,y=T)+geom_line(aes(color=as.factor(Cycle)))

0 50 100 150 200

Time

ggplot(data=a)+aes(x=Time,y=T)+geom_line(aes(color=as.factor(Cycle))) + theme(legend.position='none")

1 21— 41— 61 — 81

2 22— 42—62—82
—3 — 23— 43—63 — 83
—— 4 24— 44— 64— 84
~—5 — 25— 45—65 85
6 — 26— 46— 66 — 86
— 7 — 27— 47 — 67 — 87
— 8 — 28— 48 —68 — 88
~—9 — 29— 49—69 — 89

10 —30— 5 —70— 92
— 1 —3—5—71—9N
—12—32—52—72— 92
— 13 —33—53—73 — 93
1434 b4 T4 94
15— 35— 55 —75— 95
—— 16— 36— 5 — 76 — 96
— 17 — 37— 571 — 77 — 97
~—— 18 — 38 —58—78 — 98
19 39— 59— 79— 99
—— 20 — 40 — 60 — 80 — 100

101 — 121
102 — 122 —
103 — 123 —
104 — 124 —
105 — 125
106 — 126 —
107 — 127 —
108 — 128 —
109 — 120
110 — 130 —
1M1 — 131 —
112 — 132 —
113 — 133 —
114 — 134 —
15— 135
16— 136 —
17 — 137 —
118 — 138 —
19— 139
120 — 140 —
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141 — 161 —
142 — 162 ——
143 — 163 —
144 — 164 —
145 — 165 —
146 — 166 ——
147 — 167 —
148 — 168 —
149 — 169 —
150 — 170 —
151 — 171 —
152 — 172 —
163 — 173 —
154 — 174
185 — 175
156 — 176
157 — 177
158 — 178
189 — 179
160 — 180

#Note the Dryer.Regeneration.Cycle column values - it is unique to each Regen Cycle and represents the Event Frame,

181
182
183
184
185
186
187
188
189
190
191
192
193



ggplot(data=a)+aes(x=Time,y=T)+geom_line(aes(color=as.factor(Cycle))) + theme(legend.position="'none')

400-
300-
'—
200-
100-
0 50 100 150 200
Time

more plots and data prep

#filter to keep records with T>200; filtered dataset is renamed as al
al=subset(a, a$T>200)

ggplot(data=al)+aes(x=Time,y=T)+geom_line(aes(color=as.factor(Cycle)))

1 — 21— 44—64—84 — 106 — 134 — 158 — 178
—2 — 22— 45-—65—8 — 107 — 135 — 159 — 179
—3 — 23— 46—66—86 — 108 — 136 — 160 — 180
—— 4 — 24— 47— 67— 87 — 109 — 137 — 161 — 181
~~5 25— 48 —68—8 — 110 — 138 — 162 — 182
400 - 6 26— 49— 69— 89 — 112 140 — 163 — 183
7 — 27— 50—70—90 — 114 — 141 — 164 — 184
~——8 — 28— 51— 71—91 — 115 142 — 165 — 185
—9 —29—52—72—92 — 118 — 143 — 166 — 186
— — 10— 30— 53 — 73— 93 — 120 — 145 — 167 — 187
11— 31— 54— 74— 94 — 121 — 146 — 168 — 188
200+ 12— 32— 55— 75-—95 — 122 148 — 169 — 189
13— 33— 56— 76— 96 — 123 — 149 — 170 — 190
14— 34— 57 — 77— 97 — 124 — 150 — 171 — 191
— 15— 35—58 — 78 — 99 — 126 — 151 — 172 — 192
~—— 16— 37— 59 — 79 — 100 — 127 — 153 — 173 — 193
17— 38— 60 — 80 — 101 — 128 — 154 — 174
w 18— 40 — 61 — 81 — 102 — 130 — 156 — 175
200~ 19— 42—62— 82— 108 — 131 — 156 — 176
0 50 100 150 200 — 20 — 43 — 63 — 83 — 105 — 132 — 157 — 177
Time

26



ggplot(data=al)+aes(x=Time,y=T)+geom_line(aes(color=as.factor(Cycle)))+ theme(legend.position="'none")

400-
'_
300 -
200-
0 50 100 150 200
Time

#line up start time to @
al$Time=0
k=6
al$Time[1]=0
for (j in 2:nrow(al)) {
if (a1f$cycle[j]==al$Cycle[j-1]) {
k=k+1
}
else {
k=0
¥
al$Time[j]=k
}

algStartTime=al$TimeStamp.StartTime.Local #shorten column name
#get aggregate values for each Cycle
alRuns=sqldf("select max(Time) as TimeMax, max(T) as TMax, Time as TimeTMax, StartTime, Cycle from al group by Cycle", drv =

'SQLite')
nrow(alRuns)

## [1] 176

ggplot(data=al)+aes(x=Time,y=T)+geom_line(aes(color=as.factor(Cycle)))
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— 1 — 21— 44 —64—84 — 106 — 134 — 158 — 178

2 —— 22— 45—65—85 — 107 — 135 159 — 179
—3 — 23— 46— 66—86 — 108 — 136 — 160 — 180
I] 4 — 24— 47 — 67— 87 — 109 — 137 — 161 — 181
—5 —25—48—68—88 — 110 — 138 — 162 — 182
— 6 — 26— 49 —69 —89 — 112 — 140 — 163 — 183
—7 —2T—50—70—90 — 114 — 141 — 164 — 184
— 8 —28—51—71—91 — 115 142 — 165 — 185
— 9 —29—52—72—92 — 118 — 143 — 166 — 186
10— 30— 53— 73—93 — 120 145 167 — 187
— M — 3 —5 — 74 —94 — 121 — 146 — 168 — 188
12— 32-—55—75—95 — 122 — 148 — 169 — 189
13— 33 —5 — 76— 96 — 123 — 149 — 170 — 190
14— 34—57 — 77 —97 — 124 — 150 — 171 — 191
— 15 —35—58 —78—99 — 126 — 151 — 172 — 192
~— 16— 37— 59 — 79 — 100 — 127 — 153 — 173 — 193
~— 17— 38 —60 — 80— 101 — 128 — 154 — 174
~—— 18— 40—61— 81— 102 130 — 155 — 175

19— 42-—62 82 103 — 131 156 176
0 50 100 150 —— 20— 43— 63 — 83 — 1056 — 132 — 157 — 177

ggplot(data=al)+aes(x=Time,y=T)+geom_line(aes(color=as.factor(Cycle)))+ theme(legend.position="none")

400-
=
300-
200-
0 50 100 150
Time
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more plots and data prep2

#keep records for only the first 6 hours of each Cycle
al6@=subset(al,al$Time<=60)
ggplot(data=aled)+aes(x=Time, y=T)+geom_line(aes(color=as.factor(Cycle)))

1 — 21— 44— 64 — 84 — 106 — 134 — 158 — 178
——2 — 22— 45—65—85 — 107 — 135 — 159 — 179
—3 — 23— 46 —66—8 — 108 136 — 160 — 180

— 4 — 24— 47 — 67 — 87 — 109 — 137 — 161 — 181
5 — 25— 48— 68 — 88 — 110 — 138 — 162 — 182
400~ 6 — 26— 49— 69— 89 — 112 — 140 — 163 — 183
7 — 27— 5 — 70— 9 — 114 — 141 — 164 — 184
—8 —28—5 —71—91 — 115 142 — 165 — 185

—9 —29—52—72—92 — 118 — 143 — 166 — 186

- — 10 —30—53—73—93 — 120 — 145 — 167 — 187
— 11 —31—54—74—94 — 121 — 146 — 168 — 188

300 - — 12— 32—55—75—95 — 122 — 148 — 169 — 189
— 183 —33—56 —76—96 — 123 — 149 — 170 — 190

~—— 14— 34— 57 — 77 — 97 — 124 — 150 — 171 — 191

~—— 15— 35—58—78—99 — 126 151 — 172 — 192

16— 37— 59 — 79 — 100 — 127 — 153 — 173 — 193
~— 17— 38 —60 — 80 — 101 — 128 — 154 — 174
—— 18— 40 — 61 — 81 — 102 — 130 — 155 — 175
10— 42— 62 — 82 — 103 — 131 — 156 — 176
0 20 40 60 20— 43 — 63 — 83 — 105 — 132 — 157 — 177
Time

ggplot(data=al6@)+aes(x=Time,y=T)+geom_line(aes(color=as.factor(Cycle)))+ theme(legend.position="none")

400 -

300-

200-

0 20 40 60
Time
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#get aggregate values for each Cycle

al6eRuns=sqldf("select max(Time) as TimeMax, max(T) as TMax, Time as TimeTMax, StartTime, Cycle from alé® group by Cycle", d

rv = 'sQLite')
View(al6@Runs)
nrow(al6@Runs)

## [1] 176

#select Cycles that ran for at least 6hours i.e. has full 6 hours of data
al6eRunsBasis=subset(al6@Runs, al6@Runs$TimeMax==68)

View(al6@RunsBasis)
nrow(alé@RunsBasis)

## [1] 170

aléeBasis=subset(alee,alee$Cycle %in% aleBRunsBasis$Cycle)

ggplot(data=alé@Basis)+aes(x=Time,y=T)+geom_line(aes(color=as.factor(Cycle)))

400~

300-

Time

as.ractor(uycie)

=2 =21=43 = 63 == 82
—3 — 22—45—64 — 83
——4 — 23— 46— 65— 84
—5 — 24— 47— 66— 85

=6 ==25= 48 == 67 == 86

~——7 — 26— 49— 68 — 87
£ 8 B==27 &= 50 == 69 == 88
=9 == 28 == 51 == 70 == 89

10 B 29 S 02 77 s 92
1130 = 53 72 93
= 125= 31 = 54 == 73 == 04
——183—32—55—T74—9
— 14 —33—56 — 75— 96
— L8 FE— )
— 16 —35—58 — 77 — 100
e 17 o 37 e 09 i 75 G 101
= 18 =38 = 60 = 79 = 102

— 106 —
S 107 ===
— 108 —
= 109 ==
S 110 &=
112 5
e 114 =
—EhEE—
118
i 120 =
= 121 ==
i 122
i 123
= 124 ==
126 55
o 127
= 128 =

132 — 157 — 176
134 — 158 — 177
135 — 159 — 178
136 — 160 — 179
137 = 161 = 180
138 — 162 — 181
141 — 163 — 182
142 — 164 — 183
143 — 165 — 184
145 — 166 — 185
146 — 167 — 186
148 — 168 — 187
149 — 169 — 188
150 — 170 — 189
151 — 1711 — 190
153 — 172 — 191
154 — 173 — 192

~——19—40—61—80— 103 — 130 — 155 — 174 — 193
— 20— 42—62— 81— 105 — 131 — 156 — 175
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ggplot(data=al6@Basis)+aes(x=Time,y=T)+geom_line(aes(color=as.factor(Cycle)))+ theme(legend.position="none")

400 -

300-

200-

Time

more data prep to select golden run

#auec (aread under the curve)

al6eRunsBasis$auc=0

for (j in l:nrow(alee@RunsBasis)) {
k=al6@RunsBasis$Cycle[]]
cfRun=data.matrix(subset(al6@Basis,Cycle==k & Time<=60)%$T)
al6lRunsBasis$auc[j]l=auc(c(1:61),cfRun,type="spline') #note there are 61 rows per Cycle (time=0 to time=68)

¥

hist(al6@RunsBasis$auc) #histogram

Histogram of a160RunsBasis$auc

0 _
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o _]
™
wn _
o~
3
o
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o _]
o
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[ I I T I f 1
19000 20000 21000 22000 23000 24000 25000

a160RunsBasis$auc
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25000 -

24000 -

23000 -

S 22000-
©

21000 -

20000 -

19000 -

0 50 100 150
1:nrow(a160RunsBasisOrder)

nrow(al6@RunsBasisOrder)

## [1] 170

#pick middle 50%
indexStart=as.integer(nrow(alé@RunsBasisOrder)/4)
indexEnd=as.integer(nrow(al6@RunsBasisOrder)/4)*3
indexStart

## [1] 42

indexEnd

## [1] 126

al60RunsBasisOrderMidQ=al6@RunsBasisOrder[indexStart:indexEnd, ]
nrow(alé@RunsBasisOrderMidQ)

## [1] 85

al6eBasisOrderMidQ=subset(alé@Basis,Cycle %in% al6@RunsBasisOrderMidQ$Cycle)

gegplot(data=ale@BasisOrderMidQ)+aes(x=Time,y=T)+geom_line(aes(color=as.factor(Cycle)))
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as.factor(Cycle)

== 7 == 58 102 &= 137 == 170
== 8 == 61 == 115 = 138 8= 171
= 12 == 62 = 118 == 146 == 172

400- — 24 —63— 120 — 149 — 173
— 25— 67— 121.— 151 — 174
— 27— 68— 122— 153 — 176
—— 29 — 69 — 123 — 154 — 181
— 31 — 70 — 124 — 156 — 182
i — 33— 72— 126 — 157 — 183
— 37 — 74— 127 — 158 — 184
300-
— 38— 75— 128 — 159 — 185
— 40 — 76 — 130 — 160 — 186
= 42— 77— 131 — 162— 187
— 52— 78 — 132 — 164 — 188
—— 53 — 79 — 134 — 167 — 189
— 55 — 82 — 135 — 168 — 190
200 - — 56 — 83 — 136 — 169 — 192
0 20 40 60
Time

aTGold=al6@8BasisOrderMidQ %>% group_by(Time) %>% summarise(T=mean(T))

ggplot(data=al6@BasisOrdermidQ)+aes(x=Time,y=T)+geom_line(aes(color=as.factor(Cycle))) +geom_line(data=aTGold, size=2)

as.factor(Cycle)

— 7 — 58— 102 — 137 — 170
—8 — 61— 115— 138 — 1M
— 12— 62— 118 — 146 — 172

400~ —— 24— 63 — 120 — 149 — 173
25 — 67 — 121 — 151 — 174
—— 27 — 68— 122 — 153 — 176
29— 69 — 123 — 154 — 181
— 31 — 70 — 124 — 156 — 182
- — 33— 72— 126 — 157 — 183
— 37 — 74 — 127 — 158 — 184
300-
— 38— 75— 128 — 159 — 185
— 40 — 76 — 130 — 160 — 186
— 42 — 77— 131 — 162 — 187
52— 78— 132 164 — 188
—— 53— 79— 134 — 167 — 189
——55—82— 135 — 168 — 190
200 - — 56 — 83 — 136 — 169 — 192
0 20 40 60
Time
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testing and validation

endTime=61
endTimeText="6hrs"'
deltaE30=300
deltaE5@=358
deltaE6@=400
deltaELimit=deltaE6@

shapeOK=paste('Shape OK ',endTimeText)
shapeNotOK=paste('Shape Not OK ',endTimeText)
shapeBadData=paste('Shape bad data ',endTimeText)

#calc auc and distance metric

alRuns$deltaE=0

alRuns$deltaauc=0
aaucGold=auc(c(1l:endTime),aTGold$T[1:endTime],type="spline')

for (j in 1:nrow(alRuns)) {

k=alRuns$Cycle[]]

cfRun=data.matrix(subset(al,Cycle==k & Time<=60)$T)

if (nrow(cfRun) < endTime) <
#alRuns$delta[j]=-1
alRuns$deltaE[j]=-1
alRuns$deltaauc[j]=-1

¥

else {
#alRuns$delta[j]=Frechet(data.matrix(aTGold8T),data.matrix(subset(al,Cycle==] & Time<=66)$T))
alRuns$deltaE[j]=sqrt(sum((aTGold$T[1:endTime]-cfRun[1l:endTime])"2))
alRuns$deltaauc[j]=aaucGold-auc(c(l:endTime),cfRun[1l:endTime],type="spline")

¥

hist(alRuns$deltaE,10)

Histogram of a1lRuns$deltaE

40
J

30
1

Frequency
20
1

10

0 200 400 600

a1Runs$deltaE
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max(alRuns$deltaE)

## [1] 665.8177

View(alRuns)

alRuns$ShapeNotOK=0
alRuns$ShapeBadData=0
alRuns$ShapeStatus=shapeOk

#criteria for alert
index = alRuns$deltaE>deltaELimit

index2= alRuns$deltaE==-1
alRuns$ShapeStatus[index]=shapeNotOK
alRuns$ShapeStatus[index2]=shapeBadData

alRuns$ShapeNotOK[index]=1
alRuns$ShapeBadData[index2]=1

alRuns$ShapeNotOK=alRuns$ShapeNotOK*alRuns$Cycle*sign(alRuns$deltaauc) #ignore dissimilar shape if auc is higher
alRuns$ShapeBadData=alRuns$ShapeBadData*alRuns$Cycle

mycolors = c("black","red","darkgreen")

ggplot(alRuns)+aes(c(l:nrow(alRuns)),deltaE)+geom_text(aes(label=Cycle, color=ShapeStatus)) + scale_colour_manual(values = m
ycolors)

92
600 - 03
1
89495 93
143
E 103 142
400 - 7 105 ShapeStatus
7] 10 30 % a Shape bad data 6hrs
T 182 6
E 4611‘3 43 1 16) a Shape Not OK 6hrs
391 114 1445 191

a Shape OK 6hrs

“Pige 28 % 148
200 - 131 1
é@%%a £
61

%0 ;&6 iy 1%& 1 2
55 éj@ 10
0- 1 44 @97 140
E) 5‘0 160 150

c(1:nrow(a1Runs))

ggplot(data=subset(al,Cycle%in%alRuns$ShapeBadData))+aes(x=Time,y=T)+geom_line(aes(color=as.factor(Cycle)))+geom_line(data=a
TGold, size=2)

35



450 -

400 -

350 -

as.factor(Cycle)
1
— 44
— 90
— 91
300- — 97

140
250 -

200-

60
Time

ggplot(data=subset(al,Cycle%in%alRuns$ShapeNotOK) )+aes(x=Time,y=T)+geom_line(aes(color=as.factor(Cycle)))+geom_line(data=aTG
old, size=2)

450 -

! | \\ as.factor(Cycle)
& | | 89
|
350 - \ | \ 92
| \ 93
" \\ \ ‘ i 95
\
300~ A \ 102
A 142
1 \
| 143
| \
WV |
250 - i
L |
i \
\ \ \
v\ \
\ ¥ \
(g |
200~
0 50 100 150
Time

gegplot(data=subset(al,Cycle==93))+aes(x=Time,y=T)+geom_line(aes(color=as.factor(Cycle)))+geom line(data=aTGold, size=2)
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350 -
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250 -

200 -
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Time
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1g: Operationalize the Golden Run

Expected temperature via Pl future data tag
To operationalize the golden Dryer Outlet Temperature profile, it is written to a Pl future tag (orange
trace) for each Regeneration Cycle so that an operator can used it as a guide.

ExpectedTemperaure  Asset: | DryerA V¥

[ T — 1 L L L 1
12/11/2017 12:00:00 PM 12/1172017 6:00:00 PM

The EvalT200 generates an EF for outlet temperature>200 condition; this replicates the 200 deg F cut-off
used during R/MATLAB model development.

Dryer A
General | Child Elements | Attributes | Ports | Analyses ‘Notiﬂcation RuIeslVersion‘
uﬂl ] Name: EvalT200
e ® & @ Name Backfilling ~ [CEcbC
o = -  Dryer Regeneration Events o Categories:
O = fea  Dryer Status (v Analysis Type: () Expression (O Rollup (@ Event Frame Generation
H B FH  DryerProfile_OutletT Create a new notification rule for EvalT200
v] H  EvalT200 (V] |
® = f&  MATLAB Eval (V]
(] I ZAnalysis1 (V]
v
Generation Mode: ‘ Explicit Trigger I v] Event Frame Template: | EvalT200
Add.. v I:
Name Expression True for Seve
@ Start triggers
StartTriggerl| 'Operating State'="Regeneration" and ('Outlet Temperature'>=200) set (optional) | Non

A background Windows Script (not shown here) writes the expected temperature to a Pl future data Tag
via Pl UFL.
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Real-time scoring of temperature profile during regeneration
For real-time scoring, the temperature profile during Regeneration is compared to the golden profile
using the shape measures/distance metrics developed in R/MATLAB.

The logic is encoded in a MATLAB function that is callable from AF Asset Analytics. See files with
calcCurve prefix in the lab folder.

Documents » PIWorld2018

Name

calcCurveDistance
RUL
Scripts
R .RData

.Rhistory

¢ AlkyFeedDryer.html

%2 AnalyzeDryerData.mlx

* | calcCurveDistance.m
calcCurveDistance.prj
calcCurveDistanceFunctionSignatures json

Dryer Regenerations.txt

MATLAB code compilation and its deployment into MATAB Production Server (MPS) is outside the
scope of this Lab. For those details, see “Streaming calculation with the P1 System and MATLAB”
session.
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Dryer A

|Genera| | Child Elements | Attributes | Ports ‘ Analyses ‘Nutiﬁcatiun Rules|Versiun‘

] ] Name: MATLAB Eval
2 & @ Name Backfilling |  Description:
] Dryer Regeneration Events Categories:
-] Dryer Status Analysis Type: (@) Expression Rollup Event Frame Generation sQcC

H

J

H  DryerProfile_OutletT
HH EvalT200

fod  MATLAB Eval

H  ZAnalysis1

QOO0 O*
\
QOS OO

Add a new variable Evaluate

Name Expression
IdealData

Output Attribute
‘11' EnableF1t3 Then RecordedValues( ‘Outlet Temperature Forecast‘_.IdealDataStar‘tDate,IdeaJ.DatalMap |

MATLABEval

If (Arraylength(IdealData) > 1 AND Arraylength(CurrentData) > 1) Then MATLAB:calcCurveDistan

Map |

If (ArraylLength(IdealData) > 1 AND Arraylength(CurrentData) > 1) Then MATLAB:calcCurveDistance.calcCurveDistance
(CurrentData,IdealData) Else NoOutput()

DeltaE if ArrayLength(MATLABEval) = 2 Then Float(MATLABEval[l]) else NoOutput() DeltaE

DeltaAUC if Arraylength(MATLABEval) = 2 Then Float(MATLABEval[2]) else NoOutput() DeltaAUC

Scheduling: (e Event-Triggered (O Periodic

In the MATLABEval calculation (shown above), CurrentData is an array with current Regeneration Cycle

Dryer Outlet Temperatures; IdealData is an array of Outlet Temperatures representing an ideal i.e. a
golden run.

The function returns:

= DeltaE — shape metric comparing current profile and ideal profile
=  DeltaAUC - delta of the AUC between current and ideal

MATLAB function signatures are specified in calcCurveDistanceFunctionSignatures.json

And, periodically, say, 3 hours into the process, Pl Notification generates an email alert with an
embedded link to a Pl Vision display) if the temperature profile is dissimilar and outside specified limits.
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Dryer A

| General | Child Elements | Attributes | Ports | Analyses |Notification Rules | Version |

’ BE m ‘ Name: DryerProfile_OutletT

e B & = Name Backfilling ~ Desar{riifoe

o = [+  Dryer Regeneration Events [v] Categories:

o = fed Dryer Status [v] Analysis Type: () Expression (O Rollup ® Event Frame Generation =
‘ o ] | DryerProfile_OutletT Create a new notification rule for DryerProfile OutletT

(v] H EvalT200 [v] |

® =B feo  MATLAB Eval V]

V] H  ZAnalysis1 [v]

v

Generation Mode: | Explicit Trigger - Event Frame Template: | DryerProfile_OutletT

Add... v Evalua

Name Expression True for Severity

@ Start triggers

StartTriggerl|'DeltaE'>3@@ and 'DeltaAUC'>® //auc calculates target - actual Not Set None

HighDeltak 2018-03-01 12 0.000 generated a new notificati...

Tell me what you want to do

x D “aReply m Y Topo ¥ - @ (¥ Mark Unread I}) je
P |

fi :
i @ Reply All (53 To Manager - u = I Categorize ~
&- Delete Archive - =07 Email _ Move —_  Assign Translate
(= Forward eam tmai N o " Policy - [* Follow Up - o
Delete Respond Quick Steps & Move Tags I Editing

pismtprelay@gmail.com Gopal Gopalkrishnan

HighDeltak 2018-03-01 12:54:00.000 generated a new notification event.
o You forwarded this message on 4/18/2018 4:24 PM.

Event: HighDeltaE 2018-03-01 12:54:00.000

Name: Alert3Hrs

Server: PISRVO1

Database: Dryers

Start Time: 3/1/2018 12:54:00 PM Pacific Standard Time (GMT-08:00:00)
Target: Dryer A

Severity: None

Send Time: 4/18/2018 1:33:47 PM Pacific Daylight Time (GMT-07:00:00)
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Exercise 2 Pump/Motor — Analytics
In an equipment/asset maintenance and reliability context, the layers of analytics can be viewed as:

= UbM - Usage-based Maintenance
=  CbM - Condition-based Maintenance
=  PdM - Predictive Maintenance - AF plus third party libraries

Effectiveness

a

Predictive

Model-based
Anomaly Detection

Condition-based
Agagregations

Analytics

S s Efficiency, delta P,
Run times, Start/Stops, Rate of Change,
Usage, Limit-based Channel
Comparison, Virtual
Instrument

Manual Readings
Vibration,
Thermography, Qil
Analysis

Preventative

Calendar-based

» Efficiency

Reactive

“Break-Fix’
Run-to-Failure

PI System natively supports the required analytics for UbM and CbM. Step-by-step tutorials are already
available from hands-on lab sessions offered previously:

http://cdn.osisoft.com/learningcontent/pdfs/TechCon2016 ConditionBasedMaintenancewithPIAF.pdf

https://pisquare.osisoft.com/servlet/JiveServlet/download/96950-
21243/TechCon%202017%20CBM%20Lab%20Workbook Final.pdf

As such, in this lab, we illustrate PdAM using vibration data for a pump to predict its remaining useful life
(RUL).

We will use 2 methods for this calculation:

= the first method uses built-in AF Asset Analytics function (linear regression via exponential
curve-fit)
= the second method calls a MATLAB function (non-linear curve fit) from Asset Analytics
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http://cdn.osisoft.com/learningcontent/pdfs/TechCon2016_ConditionBasedMaintenancewithPIAF.pdf
https://pisquare.osisoft.com/servlet/JiveServlet/download/96950-21243/TechCon%202017%20CBM%20Lab%20Workbook_Final.pdf
https://pisquare.osisoft.com/servlet/JiveServlet/download/96950-21243/TechCon%202017%20CBM%20Lab%20Workbook_Final.pdf

MATLAB code compilation and its deployment into MATAL Production Server (MPS) is outside the
scope of this Lab. For those details, see “Streaming calculation with the P1 System and MATLAB”
session.

The vibration data represents the nominal percent (of normal) vibration over a period of 82 weeks; a
new value is collected every week. The vibration values increase over time as you can see from the
below graph.

In this exercise we will calculate the estimated RUL till we reach the HIHI value of 400.

Lo, L 1 L L 1

1/4/2015 11:00:00 AM 7/24/2016 11:00:00 AM

2a: Examine the Data
Let’s first take a look at the AF structure:

Open Pl System Explorer

On the top left corner, click on Database, and then double click “AFExampleRUL”
Expand Site > Unit 1 > Pump 1

Click on “Pump 1” and then click the Attributes Tab to examine it

P wnNPR
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File Search View Go Tools Help
@ Database | Query Date ~ ® & | Back () |H, Checkin =3 « [£] Refresh | New Element ~ (=] New Attribute

Elements Pump!
() Elements [ General | chid Elements | Attributes [Ports | Analyses Rules | Version |
=} ﬂ Unit1 Fitter
-8 [ |2 | name | value
3 RotEquipHealthSensor SKFCMWASS00_1] T Category: Sensor Steams
(£, Element Searches
| ‘ «F Status |Running

=] Category: Spedifications
= =] AssetType Centrifugal Pump
@ =D 123458
= =] Installedon 5/15/2013 12:00:00 AM
a =] LinkCMMS https: /fwww.google.com,
= =] LinkEngineeringDwg1
= E] LinkEngineeringDwg2
= =] LinkEngineeringDwg3
= =] Mir Flowserve
= =] Model Ix2-13
= =] Name G-3201
= ] OperatingManual hittps: . flowserve. com sites default/fles/2016-07 fpd-100-234.pdf
= [£] RatedFlow 210 US galfmin
@ =] RatedHead 130 ftH20
= =] Ratedspeed 1800 rpm
a =] SealSpec SingleMech
= =l size 320gpm
@ =] WettedMaterial CcsT
=] y: Summary
= =] Comments There have not been any comments made so far on this machine.
= =] BlementPath SiteUnit1PUmp 1
= ] LastMaintenance 1/4/2015 10:00:00 AM
B4 | =] NumStartsSincel astMaint 1548 count
= =1 Photo
< >

= =1 PhysicalLocation Not yet entered

Cliemonts = =1 ReplacementCost 0usD

\— Event Frames
B¢ | =] RunFraclast30Days 36,33353 %

| & vibrary

T B¢ | =] RunFradast365Days 2986317 %

m B¢ | =] RunHoursSincelastMaint 261h

3¢ Management

5. Click on the Rotating Equipment child element of “Pump 1”, and check its attributes
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El

File Search View Go Tools Help
@ Database ¥ Query Date ~ ® @ | Back

H, Checkln %} « [Z]Refresh | (3 NewElement =

\\PISRVO1\AFExampleRUL - Pl System Explorer (Administrator)
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Expand the “OverallBearingFault” attribute and check its child attributes

= Categary: Sensor Streams

B .7 H

<7 OveralBearingFault

B% &b
=1 Hi
=1 HiHi

&Fm
=1 Hi

H &
H &
H &

H &

=1 Maximum
¥ Matural Log
(,If MumEvents
«F PciGoodData
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300 gE

400 gE

0.007416343 gE/day
0.2 gEfday

500 gE

5.5294

82 count

99,99265 %
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Below are some important attributes we’ll be dealing with as part of the RUL calculation:

a. OverallBearingFault: the vibration nominal value. We have 82 values for this attribute,

values update every week, and will range from 49 to 252 over a period of 82 weeks
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OverallBearingFault| HIHI: this is the HIHI value for the vibration; we need to calculate
the RUL till we reach this HIHI value

OverallBearingFault| Natural Log: this will store the natural log (log base e) values of the
vibration data. The linear fit will be done on the natural log values, as opposed to the
actual vibration values

OverallBearingFault|b: this will store the intercept of the line being generated from the
moving linear regression calculation we will implement in AF Analytics on the natural log
values

OverallBearingFault| m: this will store the slope of the line being generated from the
moving linear regression calculation we will implement in AF Analytics on the natural log
values

OverallBearingFault|r_squared: this will store the r? of the line being generated from
the moving linear regression calculation we will implement in AF Analytics on the
natural log values. The closer r? is to 1, the better the fit

BearingLifeExpectancy: the calculated RUL in months till we reach the HIHI value. This
will be calculated using a moving built-in linear regression function in Pl Asset Analytics
BearingForecastedFailureDate: the predicted failure date based on the
BearingLifeExpectancy calculation

MATLAB_BearinglLifeExpectancy: the calculated RUL in months till we reach the HIHI
value. This will be calculated using a MATLAB model already in place which does a non-
linear fit for the data and “learns” as we gradually send more values to it
MATLAB_BearingForecastedFailureDate: the predicted failure date based on the
MATLAB_BearinglLifeExpectancy calculation

8. Please note that a MATLAB function was already implemented for this class and deployed in the

MATLAB Production Server (MPS) instance installed on your machine. Below are some details of
this MATLAB function:

The function returns the RUL in days after passing to it the timestamps of the vibration
values, the vibration values, and the threshold (the HIHI value of 400 in our example)
Function definition: predictNewRUL.predictNewRUL(array time, array values, number threshold)

2b: Examine the moving linear regression calculations in AF Analytics — Method 1 for

calculating the RUL

In this section, we will examine AF Analytics where we calculate the RUL based on a moving linear
regression algorithm. This is implemented because when observing the data, you can clearly see that the
curve has different slopes at different times.

vk wnN e

Open Pl System Explorer

On the top left corner, click on Database, and then double click “AFExampleRUL”

Expand Site > Unit 1 > Pump 1, and click on “RotEquipHealthSensor SKFCMWAS8800_1A"
Click the “Analyses” tab on the right

Check the “Bearing Life Calculations” analysis
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6. The first 12 formulas of this analysis are related to this first method of calculating the RUL based
on a moving linear regression fit.

The last 4 formulas of this analysis calculate the RUL based on a non-linear MATLAB model, this
will be discussed in the next section.

7. The first 12 formulas of the “Bearing Life Calculations” analysis which relate to this section are
shown below:

Name Expression Output Attribute

PCtgoodDATA

if EnableFit AND Not (LinearReg then (Fit[1]*24*3600, else )

8. Below is a brief description of each formula:

a. pctgoodDATA: checks the percentage of good data for the vibration values, from the
Last Maintenance Date till the time of the calculation

b. NumOfEvents: calculates the number of vibration values from the Last Maintenance
Date till the time of the calculation

c. EnableFit: a Boolean to determine if we can attempt to fit a linear line. We will enable
the fit if we have more than 24 values
NatlLog: calculates the natural log value of the vibration data

e. Timel2back: gets the time 12 weeks earlier than the calculation time, which is 12 values
in the past (because we have one value per week). This is used for doing a linear
regression on every 12 values, since the slope of the curve is changing

f. LinearRegr: performs a linear regression on the past 12 natural log values, and returns
and array of 3 values; the slope of the line, the intercept, and the r?

g. Fit: stores the array value from the previous formula assuming no errors were
generated

h. m: extracts the slope of the line generated from the array result of the LinearRegr
formula

i. b:extracts the intercept of the line generated from the array result of the LinearRegr
formula

j.  rsquared: extracts the r? value of the line generated from the array result of the
LinearRegr formula

k. LifeExpectancy: calculates the RUL till we reach the HIHI value of 400, based on the
slope, the intercept, and the time of the calculation. The r?is checked to make sure its
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value is not too low, which might result in an unreliable RUL prediction. The prediction is
converted to hours and mapped to the BearingLifeExpectancy attribute, which is set to
convert hours to months in the attribute template

|.  ForecastedFailDate: uses the calculated LifeExpectancy and the calculation time to
determine the estimated fail date

2c: Examine the MATLAB calculations in AF Analytics — Method 2 for calculating the RUL
In this section, we will examine the calculations in AF Analytics which calls the predictNewRUL MATLAB
function described in section 2a, in order to calculate the RUL based on a non-linear model which
constantly “learns” as it gradually receives new data.

ok wNRE

Open Pl System Explorer

On the top left corner, click on Database, and then double click “AFExampleRUL"”

Expand Site > Unit 1 > Pump 1, and click on “RotEquipHealthSensor_ SKFCMWAS8800_ 1A"
Click the “Analyses” tab on the right

Check the “Bearing Life Calculations” analysis

The last 4 formulas of this analysis are related to this second method of calculating the RUL
using the integration with MATLAB. The first 12 formulas of this analysis were discussed in the
previous section.

The last 4 formulas of the “Bearing Life Calculations” analysis which relate to this section are
shown below:

ForecastedFailDateMatlab | If ( Val(RawTi tamps) OR E )) Then ! t ) Else (IF th(Rawval ) = @) the

Below is a brief description of each formula:

a. RawValues: retrieves an array of values of vibration data for the past 12 weeks (12
values in total)

b. RawTimestamps: retrieves an array of timestamps of the values of vibration data for the
past 12 weeks (12 timestamps in total)

c. LifeExpectancyMatlab: calculates the RUL till we reach the HIHI value of 400 by calling
the predictNewRUL MATLAB function and passing to it the RawTimestamps array,
RawValues array, and the Vibration HIHI Threshold of 400. The prediction is converted
to hours and mapped to the MATLAB_BearingLifeExpectancy attribute, which is set to
convert hours to months in the attribute template

d. ForecastedFailDateMatlab: uses the calculated LifeExpectancyMatlab and the
calculation time to determine the estimated fail date

2d: Simulating the calculations
In this section, we will simulate receiving the vibration data over a period of 82 weeks and examine the
results of the RUL calculations for both methods.

1.

Open Internet Explorer and click on the “PI Vision” Bookmark
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Use the tree menu on the left to navigate to the “Vibration RUL” displays

Click on the “Vibrations - life expectancy - Current” display

Open the following folder on your Desktop: Replay Data

Right click the “Pl_ReplayVibrationValues.ps1” file and choose Edit. The file should open in
PowerShell

Click the “Debug” tab from the top menu, and choose “Run/Continue”, this will start filling up
the 82 vibration values and will call the “Bearing Life Calculations” Analysis at the end, to
calculate the RUL using both methods

Go back to the Pl Vision display you previously opened in step 3, and observe as the data is
coming in, and the RUL calculations are displayed. Are both methods generating similar RUL

values?

Vibrations - Ife expectancy - Curent  Asset: | RolEquipHeatnSensor_SKFCMWABS00_1 +AdtocDsplay  [Jl)

Bearing Forecasted Failure Date  7/5/2018 8:24:25.795 AM MATLAB Bearing Forecasted Failure Date  7/21/2018 1:30:11.22 PM
Bearing Life Expectancy 2528 MATLAB Bearing Life Expectancy 3.061
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Other resources
At TechCon 2016, we reviewed an end-to-end use case for developing a machine learning (multivariate
PCA - principal component analysis) model to predict equipment failure.

And, in TechCon 2017, we covered an anomaly detection use case in HVAC air handler operations —
using both PCA and one-class SVM algorithms.

Both labs are available at http://learning.osisoft.com VLE (virtual learning environment)
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https://en.wikipedia.org/wiki/Principal_component_analysis
https://pisquare.osisoft.com/docs/DOC-3463-predicting-remaining-useful-life-and-equipment-failure-using-a-machine-learning-multivariate-model
https://pisquare.osisoft.com/groups/facilities/blog/2018/01/04/data-sciencemachine-learning-use-case-with-hvac-air-handler
https://en.wikipedia.org/wiki/Support_vector_machine
http://learning.osisoft.com/

Have an idea how to
improve our products?

OSlsoft wants to hear
from you!

https://feedback.osisoft.com/
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OSlsoft.

Pl \World

Users Conference « Barcelona 2018

Save the Date!

OSlsoft Pl World Users Conference in Barcelona. September 24-27, 2018.

Register your interest now to receive updates and notification early bird registration opening.

http://pages.osisoft.com/UC-CORP-Q3-18-
EMEAUsersConference ReqisterYourlnterest2018.html

REGISTER YOUR INTEREST
FOR OUR 2018 EVENT!
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http://pages.osisoft.com/UC-CORP-Q3-18-EMEAUsersConference_RegisterYourInterest2018.html
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Pl SYSTEM LEARNING
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After the conference, the PI SYSTEM LEARNING
does not have to stop. All registered attendees for
Pl World SFO 2018 will have access to all Pl World
Hands-on Lab cloud environments for 21 days using
the discount cod below. You will receive detailed
instructions via email after the conference.

Discount Code: 2018UCSF-LAB-100

Offer expires June 30, 2018

} }} learning.osisoft.com




